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Lesson Objectives 

• Learn about the different formats available for sales forms 

• Save sales and purchase forms in portable document format (PDF) 

• Practice creating a new invoice 

• Learn the purpose and use of the QuickBooks Item list 

• See how QuickBooks records the information you enter on sales forms 

• Memorize an invoice transaction for reuse 

• Add a new item to the Item list 

• Add a new price level to the Price Level list 

• Associate a price level with a customer 

• Create invoice letters 

• Generate reminder statements 
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Use Sales Forms for Payment in the Future 

Any time you make a sale in your business, you record it in QuickBooks on a sales form. A sales form 
can be an invoice (when you expect payment to come later), a sales receipt (when you receive 
payment at the time you make the sale), or a credit memo (when you issue a credit on your 
customer’s account or a customer refund, perhaps because they’ve returned something they’ve 
bought). 

The type of sales form you use (invoice or sales receipt) depends on whether you expect payment in 
the future or at the time of the sale. If you expect to receive payment at some future date, you enter 
an invoice.  

 Step-by-Step: Display a Completed Invoice Form in QuickBooks 

1. Open the Customer Center from the Customers drop-down menu (or any of the other access 
points). 

2. Click on the name of the customer whose invoice you would like to view. 

3. From the Transactions tab for that customer, double-click on the invoice to open the invoice form. 
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4. Close the invoice (it’s already been created and saved, and so you can just hit the Esc key to 
close it).  
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Use Sales Forms for Payment at the Time of Sale 

If you receive full payment at the time you make a sale — either by cash, check or credit card — you fill 
out a sales receipt instead of an invoice. Like the invoice, the QuickBooks sales receipt includes 
information about the items or services purchased, but it also includes information about how 
payment was made. (Think of the sales receipt as the QuickBooks equivalent of a cash register 
receipt at a retail store.) The sales receipt completely bypasses the Accounts Receivable account. 

 Step-by-Step: Display a Completed Sales Receipt in QuickBooks 

1. Open the Customer Center from the Customers drop-down menu (or any of the other access 
points). 

2. Click on the name of the customer whose sales receipt you would like to view. 

3. From the Transactions tab for that customer, double-click on the sales receipt to open the Sales 
Receipt form.  

Note the Deposit To account (whether it’s the Checking account, other bank account, or 
Undeposited Funds). Undeposited Funds will be discussed in more detail in Lesson 7 under 
Make Deposits. 

 

4. Close the Enter Sales Receipts window. 
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Fill in a Sales Form 

Filling in an invoice is just like filling in a paper form: enter the customer information first (this will 
populate the header portion of the invoice), followed by a description of the charges (this will 
populate the detail portion of the invoice). 

 Step-by-Step: Enter Customer Information on an Invoice 

1. On the Home page, click Create Invoices (or select CTRL+i or Customers  Create Invoices; 
there are several other ways to open the Create Invoices window). 

2. If you have custom invoice templates, choose the invoice template you would like to use from the 
drop-down list. 

3. In the Customer:Job field, enter the name of the customer/job for whom you wish to create an 
invoice. 

4. If the Billable Time/Costs window pops up, choose to add billable time or expenses.  

 

NOTES 
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Fill in the Line Item Area 

In the bottom half of the invoice (the detail or body of the invoice), you list each service or product 
you’re selling on its own line, along with the amount the customer owes for that item. Because 
information about individual items is on separate lines, the lines are called line items. 

But items are not just products you sell or services you provide to clients. Line items can be anything 
you might want to put in the detail area of an invoice, like a discount, subtotal line, markup or sales 
tax calculation. 

 Step-by-Step: Complete the Line Item Area of an Invoice 

1. In the Item field, choose the item you would like to add to the invoice. If you chose to add 
billable expenses from the last exercise, these items will already appear in this section.  

2. Press Tab until you reach the Quantity column. 

3. Enter the quantity of the item for which you wish to invoice in the Quantity column. 

4. Press Tab to enter the rate or per unit price for this item. If this item has been set up with a 
default rate, it will automatically appear on the line, but you can overwrite it. 

5. Press Tab to see the amount or extension of the quantity multiplied by the per unit price. 

6. Let QuickBooks populate the Tax code for this item automatically, but you can overwrite it by 
selecting a different tax code from the drop-down. 

 

NOTES 
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Complete the Sales Form 

 Step-by-Step: Complete and Record the Invoice 

1. At the top of the screen in the Main tab of the ribbon, click on the drop-down under Print and 
choose Preview. 

2. Click Zoom In above the previewed form and use the scroll bars to see the invoice items at 
greater magnification. 

 

3. Click Close. 
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4. Invoices and other sales forms can be printed, emailed or saved as PDFs by clicking on the drop-
down under Preview or Email in the Main tab of the ribbon at the top of the form. 
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5. In the Create Invoices window, record the sale and close the window by clicking Save & Close. 

 

QuickBooks records the invoice in your Accounts Receivable register.  

If this were a sales receipt rather than an invoice, QuickBooks would record the sale in your 
Undeposited Funds account, where it would stay until you deposit the money at the bank. This 
assumes Undeposited Funds was chosen as the Deposit To account. If a checking or savings account 
was selected as the Deposit To account, no separate deposit transaction would be required; the 
money from the sales receipt goes directly into the bank account. The option to select where to 
deposit the payment is available only when the Payments preference Use Undeposited Funds as a 
default deposit to account is turned off. 
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The Accounts Receivable register keeps track of how much money your customers owe you. 

 Step-by-Step: See the Accounts Receivable Register Display a Completed 
Sales Receipt  

1. Open the Chart of Accounts. 

2. In the Chart of Accounts, double-click the Accounts Receivable account. The register for 
Accounts Receivable displays. 

3. To open a transaction, double-click on the transaction in the register, or click on it once, then 
click the Edit Transaction button at the top of the Accounts Receivable register toolbar. 

 

4. Close the register. 
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Repeat a Sale 

Many of the sales you make in your business are ones you repeat again and again. For example, you 
may have a standing monthly order from a customer, or you may perform essentially the same 
services for more than one client. QuickBooks lets you memorize sales forms so you don’t have to 
retype the information. In fact, QuickBooks allows you to memorize a transaction so it is automated 
on a schedule if it’s something that happens regularly in exactly the same way. 

 Step-by-Step: Memorize the Invoice 

1. Make sure you have the invoice you want to memorize displayed on your screen. 

2. From the Main tab of the ribbon in the upper right of the task bar, choose Memorize. The 
Memorize Transaction window appears on top of the invoice. 

 

3. In the Name field, type a description that will help you recognize the memorized invoice or keep 
the default description QuickBooks has provided. 

4. Click the radio button next to Do Not Remind Me. 

5. Click OK. If your computer’s sound is turned on, you’ll likely hear a camera taking a picture. 
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6. Close the Create Invoice, Accounts Receivable register and Chart of Accounts windows. 

 Step-by-Step: Recall a Memorized Sale  

1. From the Lists menu, choose Memorized Transaction List. 

 

 

2. Double-click the transaction you just added. Remember, this is just a snapshot copy of an invoice 
that you’ve memorized, not the original invoice. It is the beginning of a new invoice that already 
has some copied information from the original invoice. 

3. Make any necessary changes on this copy of the memorized invoice (such as the date or other 
details) before you save it. 

4. Click Save & Close to record the invoice. 

5. Press the Esc key to close the Memorized Transaction List. 

NOTES 
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Create Batch Invoices 

Batch invoices are a way to assemble a list of customers to whom you can send similar invoices all at 
once. This can be great for recurring service billing. 

 Step-by-Step: Create a Batch Invoice 

1. From the Customers menu, choose Create Batch Invoices. 

2. Click OK to close the Is your customer info set up correctly? message. 

 

3. In the Look for field, you can search for an item description. 

4. Click Search. 
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5. In the Billing Group field, enter a name for your batch. If you enter a name that does not exist, 
you will receive a prompt to set up this group. 

6. Highlight each client from the search results you wish to add to the Billing Group or you can click 
Select All. Use the Add button to add clients to your list. 

 

7. Click Save Group. 

8. Click Next. 
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9. Choose the date of the invoices that are being issued in one batch as well as the invoice 
template you wish to use for the entire batch. 

10. Enter the information you would like on your invoice. 

11. Click Next. 

 

  

  



Lesson 6 — Enter Sales Information Create Batch Invoices 

QuickBooks Desktop 2020 Client Training 20 

12. Review the list of customers checked in the next window and click Create Invoices. 

 

13. The Batch Invoice Summary appears. Click Email to send the invoices to your customers or Print 
to print the invoices. 

14. Click Close to close the Batch Invoice Summary. 
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Enter a New Item 

Items are what we use on sales forms like estimates, sales orders, invoices and sales receipts. Items 
show the products/services that are sold and each item is mapped to one or more accounts in 
QuickBooks. Items can be mapped to one, two or three accounts, depending on the item setup. 

• One-sided items – These items are used on either a sale or a purchase form, but not both. For 
example, if you sell consulting services, you may have an item named Consulting for use on your 
invoices. This item will be mapped to an income account to view on your Profit & Loss report. If 
this item (meant for sales transactions, in this example) were used on a purchase transaction, it 
would post a negative transaction to your income account. 

• Two-sided items – These items are used on both a sale and a purchase form. The setup of these 
items allows you to post to an income account when used on a sales form and post to an 
expense account when used on a purchase form. 

• Three-sided items – These items are used for inventory. The setup of these items allows you to 
purchase the item and receive it into your Inventory asset account (part 1). When you sell the 
inventory, the item posts to your Income account (part 2) and makes a Cost of Goods Sold entry 
(part 3). 

In this section we will look at a one-sided item entry. 
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 Step-by-Step: Add a One-sided Item 

1. From the Lists menu, choose Item List. 

 

2. Click the Item menu button at the bottom left of the window then choose New. 
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3. In the New Item window, choose an item type (e.g., Service as in the screen capture below), from 
the Type drop-down list. 

 IMPORTANT: When you select an item type, a description of how that item should be used will appear to 
the right of the drop-down box. 

 

4. Assign an item name or number in the Item Name/Number field. 

5. In the Description field, enter the default information you would like to appear when this item is 
used on a form. (This information can be overwritten on any individual transaction.) 

6. You can assign a standard per unit selling price in the Rate field.  

7. In the Tax Code field, assign a standard taxable or non-taxable code. 

 IMPORTANT: Items marked as Non-taxable in the setup will not accrue sales tax on sales forms. See the 
Sales Tax training section for additional information. 

8. In the Account field, choose the appropriate Income account to post to when this item is used on 
sales forms. 

9. Click OK to add the new item to the Item List. 

10. Close the Item List. 
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Create New Price Levels 

For each price level you create, you assign a name and percentage increase or decrease to the 
item’s base or standard sales price. You can create up to 100 price levels in QuickBooks Pro and 
Premier to use on invoices, sales receipts, estimates and credit memos. To enable price levels in a 
company, click Edit Preferences Sales & Customers  Company Preferences  Enable 
Price Levels. 

 Step-by-Step: Create a New Price Level 

1. From the Lists menu, choose Price Level List. 

 

2. From the Price Level menu button, choose New. 

3. In the Name field, enter a name for the price level. 

4. From the Type drop-down list, select Fixed % or Per Item. This setting determines if you have a 
fixed markup/discount or if you would like to set up custom prices per item. (Per Item Price 
Levels are not available in QuickBooks Desktop Pro.) 

5. Set your rounding parameters. 

6. Click OK. 

7. Close the Price Level List. 
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Associate Price Levels with Customers 

When you assign price levels to customers, QuickBooks calculates rates and amounts on sales forms 
based on the price level associated with that customer. 

 Step-by-Step: Associate a Price Level with a Customer 

1. Open the Customer Center.  

2. In the Customers & Jobs List, select the customer whose price level you wish to set. 

3. Double-click on the customer name to open the customer detail page. 

4. Click the Payment Settings tab. 

5. From the Price Level drop-down list, choose the price level you want to associate with the 
customer. 

 

6. Click OK to close the Edit Customer window and save your changes. 
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Now when you create a sales form for this customer, the price will automatically be adjusted 
according to the price level. However, you will still have the opportunity to select the base or 
standard price, or any of the other prices associated with other price levels, for each item (by clicking 
on the drop-down next to the rate that appears). You will also be able to overwrite the price 
altogether and enter a custom price for this sales form. See the next section, Assign Special Prices to 
Individual Line Items, for situations in which you might want to use this feature. 

NOTES 
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Assign Special Prices to Individual Line Items  

In addition to associating price levels with customers, you can also use other price levels and special 
prices on an individual basis on sales forms. Some examples of when you might want to do this are: 

• You’ve associated a price level with a customer but want to charge the base sales price for an 
item on a sale to that customer 

• You want to use a price level for one or more items, but you don’t want to assign a price level to 
the customer for whom you’re recording the sale  

• A customer has negotiated a special one-time-only price with you on specific items  

 Step-by-Step: Apply a Price to a Single Line Item 

1. In a sales form with line items click in the Rate column and select the price level you want to use 
from the drop-down list that displays (or you can enter your own price for that item, even if it is 
not in the drop-down list). 

2. When you move out of that field on the form QuickBooks recalculates the amount and balance 
due. 

NOTES 
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Use the Income Tracker 

The Income Tracker Center helps you manage collecting payments from your customers. It lists all 
overdue and nearly-due invoices in a single place, as well as unbilled estimates. You can send email 
reminders to one customer or many customers, and it tracks customer notes about your collection 
efforts. 

 Step-by-Step: Review Overdue and Nearly-Due Payments 
for All Customers 

1. From the Customers menu, select Income Tracker (or open the Customer Center and click on 
Income Tracker). 

2. Click on any of the money bar’s colored tabs on the top to filter the information, if desired. 

 

3. Click on the down-facing arrow next to Select in the Action column for a list of actions you can 
take on each line. 

4. In the Unbilled section (the left half) of the money bar, click on the colored tab for Estimates. 
These are open estimates that can be turned into invoices by using the Action field. 
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5. Place checkmarks in the boxes in the far left column next to each estimate (or one checkmark in 
the top box to indicate you are choosing all of them). Click on Batch Actions at the bottom 
which, in this case, enables you to batch email them or mark them inactive. 
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6. The Manage Transactions button at the bottom left enables you to launch a new customer-
related transaction such as a new invoice or estimate, or to edit the currently highlighted row. 

 

7. Close the Income Tracker. 

NOTES 
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Create Single Invoice Letters 

 Step-by-Step: Create an Invoice Letter 

1. From the Reports menu, choose Customers & Receivables, then choose Open Invoices from 
the submenu. 

2. In the on-screen Open Invoices report, double-click the open invoice for which you would like to 
send a letter. 

3. Under the Send/Ship tab of the ribbon at the top, click the Prepare Letter icon to display the 
drop-down list. 

4. Select Prepare Letter. If QuickBooks prompts you to find letters, click Copy. 

5. Choose the type of letter you wish to create. 

 

6. Click Next. 
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7. Enter the appropriate name and title for the letter signature. 

 

8. Click Next. 
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9. In the next screen, indicate whether you wish to print envelopes as well. If you wish only to print a 
letter, select Cancel. 

 

10. You can choose to print the letter (and envelope) from Microsoft Word® if you wish. 

11. From the Window menu, choose Close All. 

NOTES 



Lesson 6 — Enter Sales Information Generate Reminder Statements 

QuickBooks Desktop 2020 Client Training 34 

Generate Reminder Statements 

Reminder statements summarize a customer's account by listing recent invoices, credit memos and 
payments received. You can use reminder statements when you bill through invoices but want to 
remind your customers about delinquent payments and/or total outstanding balances. 

Reminder statements are different from other forms in QuickBooks such as invoices, sales receipts or 
checks in that they are not transactions; you can think of them as reports for your customers. 
Furthermore, because QuickBooks already has all the information you need to create reminder 
statements, you don't have to fill them out. Instead, you review the information that will appear on 
each statement, decide whether to add finance charges, and generate them. 

 Step-by-Step: Generate Reminder Statements  

1. Under the Company menu item click Home to display the Home page, then click Statements (or 
from Customers, select Create Statements). 

 

2. For Statement Date, enter the date you want to appear on the statement. 
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3. Set your statement period in the Statement Period From/To fields or select All open 
transactions as of statement date. 

4. In the Select Customers section, choose how you would like to create the statements. Select 
additional options as they apply. Click Assess Finance Charges if you would like to add finance 
charges to the statements. (If you want to assess finance charges without sending out statements, 
you can click on Customers  Assess Finance Charges or access the Finance Charges icon 
from the Home page.) 
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5. Enter an assessment date in the next window (the Assess Finance Charges window) if applicable. 
Click Assess Charges.  
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6. Back in the Create Statements window, click Preview. Those statements which reflect finance 
charges will have a listing with “INV #FC” in the statement. 

 

7. Click Close. 

8. Close the Create Statements window. 

NOTES 
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Enter Sales Information — Review Questions 

1. When receiving payment at the time of sale, you create a ___________________________ in 
QuickBooks. 

2. When customers are returning items, you record the return on a 
__________________________________. 

3. In QuickBooks you can record payments by customers made using which of the following? 

a. Cash 

b. Check 

c. Credit card 

d. All of the above 

4. True or false: QuickBooks lets you save sales forms as PDF files. 

a. True 

b. False 

5. If you regularly invoice a customer for similar items or services, you can ______________________ 
the invoice to save time. 
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic 
below? 

a. __________________________________ 

b. __________________________________ 

c. __________________________________ 

 

7. List the item types used in the line item area of the invoice above. 

___________________________________________________________________________________________
___________________________________________________________________________________________
___________________________________________________________________________________________
__________________________ 

8. On which of the following can you not use price levels? 

a. Invoices 

b. Sales receipts 

c. Credit memos 

d. Purchase orders 
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9. QuickBooks Pro allows you to assign price levels or special prices to which of the following? 

a. Specific customers 

b. Individual line items on sales forms 

c. Both a and b 

d. None of the above 

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a 
certain price level, what price might appear on an invoice for the wood door if that price level is 
used? 

a. $120.11 

b. $120.89 

c. $119.89 

d. $119.11 

11. Which of the two methods described in this lesson for providing customers with information 
about overdue invoices allows you to assess finance charges? 

a. ___________________________________________ 

b. ___________________________________________ 
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Review Activities 

1. Create an invoice for Rock Castle Construction that uses the new Repairs:Plumbing line item. 
Create the invoice for a new customer by adding information to the Customer list on the fly. 

2. Filling out a sales receipt is similar to filling out an invoice form. Create a sales receipt for the 
customer Rock Castle Construction and select the Undeposited Funds option. (You need to 
select this option only if the preference to use that account as the default deposit to account is 
not set.) After you create the sales receipt, open the Undeposited Funds account register to see 
the transaction QuickBooks created automatically. 

3. Create a new price level for Rock Castle Construction for their January sales event. You want all 
the prices to be 10% off and rounded to the nearest $.95. Then create an invoice and add some 
items. Apply the January sales event price level and see the effect on the price. How would you 
change the price level so all prices are rounded to the nearest $.49? 
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Answers to Review Questions 

1. When receiving payment at the time of sale, you create a sales receipt in QuickBooks. 

2. When customers are returning items, you record the return on a credit memo. 

3. In QuickBooks you can record payments received from customers using which of the following? 

a. Cash 

b. Check 

c. Credit card 

d. All of the above 

4. True or false: QuickBooks lets you save sales forms as PDF files. 

a. True 

b. False 

5. If you regularly invoice a customer for similar items or services, you can memorize the invoice to 
save time. 
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6. From which list (or lists) does QuickBooks get the information for A, B and C in the graphic 
below? 

a. Customers & Jobs List 

b. Customers & Jobs List (if associated terms with the customer); Terms List 

c. Item List 

 

7. List the item types used in the line item area of the invoice above. 

Service 

8. On which of the following can you not use price levels? 

a. Invoices 

b. Sales receipts 

c. Credit memos 

d. Purchase orders 
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9. QuickBooks Pro allows you to assign price levels or special prices to which of the following? 

a. Specific customers 

b. Individual line items on sales forms 

c. Both a and b 

d. None of the above 

10. If a wood door’s base price is $120.00 and you set the rounding option to 1.00 minus .11 for a 
certain price level, what price might appear on an invoice for the wood door if that price level is 
used? 

a. $120.11 

b. $120.89 

c. $119.89 

d. $119.11 

11. Which of the two methods for providing customers with information about overdue invoices 
allows you to assess finance charges? 

a. Invoice letters 

b. Reminder statements 
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